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Microsoft Office 365:  
Tips to Save You Time and 
Improve Productivity  
 

Empower every person and every organization on the planet to achieve more 

 

As we think about empowering everyone, and helping them achieve more, it helps to understand what is 

holding people back today. What keeps them from achieving more? 

 

We think we can help people achieve more by giving them the tools to overcome the limits of time, place and 

complexity.   

 

Why We’re in the Business of Small Business 

 Small businesses make a big difference to the economy. 

 According to the International Organization for Standardization (ISO), small and midsize businesses are 

responsible for 50% of worldwide economic output.   

 Small businesses are adopting technology that helps expand their reach and grow their revenue, making 

them important economic drivers and effective competitors with businesses of all sizes.  

 Big enterprises no longer have the edge! In fact, for small businesses worldwide, technology has a 

tremendous effect on the bottom line.  

 Mobility is enabling teams to work together from anywhere. Thanks to cloud services, small businesses 

are expanding their reach across boundaries to serve customers and employ people from other regions, 

countries, and continents. 

 Microsoft cares a great deal about small business owners and managers; What keeps you up at night 

and what gets you to jump out of bed in the morning. We believe the right technology can make a 

positive difference in reducing worry, encouraging innovation, and advancing success.   

 

 

 

 

 

 

 

 

 

 

 

 

Achieve more with Top 15 Productivity Tips for Office   |  Companion Guide 

 
 



Achieve more with Top 15 Productivity Tips for Office | Companion Guide 

 

 

 

Table of Contents 
 

Do Business Anywhere ....................................................................................................................................... 4 

Office apps—even better with Office 365 .............................................................................................................................................. 4 

TIP #1 (OneNote) - Take notes on any device or platform, and access from anywhere, with OneNote....................... 4 

TIP #2 (Office Lens) - Save anything on your phone to OneDrive, with Office Lens ............................................................. 5 

TIP #3 (PowerPoint) - Share and Collaborate with PowerPoint on shared projects, from anywhere ............................. 6 

TIP #4 (Skype for Business) - Collaborate in real-time with Co-author, right from within Skype for Business .......... 7 

TIP #5 (Skype for Business) - On the move, easily Transfer your Skype for Business call to your smartphone ......... 7 

Improve Efficiency and Profitability ................................................................................................................. 9 

Collaborate on files from anywhere, with Business-class mobile apps ....................................................................................... 9 

Share files internally and externally, with Office 365 .......................................................................................................................... 9 

TIP #6 (Excel) - Quickly split column data with Flash Fill .................................................................................................................. 9 

TIP #7 (Excel) - Need to visualize your data? Use the Quick Analysis tool in Excel ............................................................ 10 

TIP #8 (Excel) - Discover geospatial patterns with 3D Maps ........................................................................................................ 11 

TIP #9 (Outlook) - Save time by quickly Attaching Files Without Searching in Outlook .................................................. 13 

TIP #10 (Outlook) - Use Outlook to check availability, Schedule a Skype Meeting, and set meeting options........ 14 

TIP #11 (Word) - Quickly and easily apply consistent document formatting with Styles ................................................ 15 

TIP #12 (Word) - Easily navigate your way through large or complex documents ............................................................ 16 

TIP #13 (PowerPoint) - Master Slide saves time by changing the Default Font for all text ............................................. 17 

TIP #14 (PowerPoint) - Give your presentations more impact, insert or Link to a YouTube video .............................. 18 

TIP #15 (Skype for Business) - Record all aspects of a Skype for Business session with Recording and Playback 19 

Still tethered to your desk phone? Cloud PBX with advanced features .................................................................................. 19 

Offer your customers the ability to schedule their own appointments online, with Bookings ...................................... 20 

Safeguard Your Business ................................................................................................................................. 21 

For the security and control you need, Business-class mobile app........................................................................................... 21 

Thank You .......................................................................................................................................................... 23 

 

  



Achieve more with Top 15 Productivity Tips for Office | Companion Guide 

 

 

Do Business Anywhere  

Office apps—even better with Office 365  
Access the Office apps you use and the files you need seamlessly, from your desktop to your mobile devices, 

anywhere you are.  

 

Store, sync, and share files simply... 

 Always have the latest version of files -- Having your files stored online makes it easy to store, organize, 

and share them, so you can work on documents with teammates, share reports with business partners, 

or connect with customers. Your files are always up to date, so everyone has access to the latest version.  

 Get room for all your files -- With 1 TB of personal document storage, you can store all your files online 

and access them anywhere from your PC/Mac or your iOS, Android™, or Windows device.  
 Share with anyone you choose -- You can share files inside and outside your company. You always 

control access.  

 

The mobile apps available with Office 365 business plans include: 

 Word 

 Excel 

 PowerPoint 

 OneDrive for Business 

 Skype for Business 

 Yammer 

 OneNote 

 Bookings 

 and more apps for business are also available. 

 

(iTunes, iPhone, and iPad are registered trademarks of Apple Inc., registered in the U.S. and other countries. Android is a 

trademark of Google Inc.) 

 

TIP #1 (OneNote) - Take notes on any device or platform, and 
access from anywhere, with OneNote  
OneNote is a digital notebook that’s perfect solution for creating, organizing, searching, and sharing notes 
online.  

 

 It stores your notebooks in the cloud, so you can access your work from anywhere and share it with your 

colleagues any time.  

 OneNote works on any device or platform. 
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 Available on Windows, Mac, iOS, Android and web.  

 

Create your way -- Write or type anywhere, clip from the web or drop in content from your Office docs. 

Work together, or collaborate with anyone -- Shape ideas with a team or plan meals with your family. Stay on 

the same page and in sync. 

Think with ink -- Scribble notes by hand. Express your insights with shapes and colors. A stylus or fingertip is 

the only tool you need. Take handwritten notes and convert them to typed text later. Highlight what's important 

and express ideas with colors or shapes. 

Better with Office -- OneNote is a member of the Office family you already know. Shape notes with points 

pulled from Outlook email, or embed an Excel table. Export notes as PDF, or send notes attached to an Outlook 

email. Get more done with all your favorite Office apps working together. 

 

TIP #2 (Office Lens) - Save anything on your phone to 
OneDrive, with Office Lens  
Office Lens is a handy capture app that turns your smartphone into a pocket scanner, and it works with OneNote 

so you’ll never lose a thing. Use it to take pictures of receipts, business cards, menus, whiteboards or sticky 

notes—then let Office Lens crop, enhance and save to OneNote.   

 

Just like that—all the scanned images you capture from Office Lens are accessible on all your devices. 

 

Office Lens is like having a scanner in your pocket. 

 

 You can use Office Lens to convert images to PDF, Word and PowerPoint files, and even save images to 

OneNote or OneDrive.  

 It's a great way to capture notes and info from whiteboards, menus, signs, or anything with a lot of text.  

 You don't need to jot down notes, rely on blurry pictures, or worry about misplacing your notes.  

Figure 1.1.1 
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 It’s great for capturing sketches, drawings, and equations too, and even images without text.  
 Office Lens gets rid of shadows and odd angles so images are easier to read.  

 

Save anything on your phone to OneNote with Office Lens: 

 You can download Office Lens for free for Windows Phone, iPhone (iOS), and Android too. 

 

TIP #3 (PowerPoint) - Share and Collaborate with PowerPoint 
on shared projects, from anywhere  
In PowerPoint 2016 for Windows, it's easier than ever to share and collaborate on your presentations.   

 

 When you share your files by using OneDrive or SharePoint Online for Office 365, you can invite people 

to the presentation directly from within PowerPoint, or send a PDF or PowerPoint file as an email 

attachment.  

 Co-author with your team on the same presentation at the same time, from anywhere, and at a glance 

see who’s working and where. 
 

Here’s what you do:   
 

Share your presentation via OneDrive or SharePoint (Figure 1.3.1):  

1. Open your PowerPoint presentation, and choose the Share tab on the far-right side of the menu bar 

(ribbon).  

2. If you haven't saved your presentation to OneDrive or SharePoint Online for Office 365, you'll be 

prompted to do so now.  

a. Choose Save to Cloud, enter a file name, and choose a location to save your presentation.  

3. Once your presentation is saved to a shared location, you can invite others to work on it.  

a. In the Invite people box, enter the email address of the person you'd like to share to.  

b. If you already have the person's contact info stored, you can just enter their name.  

c. To share with more than one person, use semicolons to separate the names or email addresses.  

Note: You can also send your presentation as an attachment—as a copy or as a PDF— to an email message.  

Figure 1.2.1 
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TIP #4 (Skype for Business) - Collaborate in real-time with  
Co-author, right from within Skype for Business  
Collaborate with others when creating documents, spreadsheets or presentations.   

 

 Use Office 365 and Skype for Business 2016 

to co-author and edit while in a meeting or 

instant message (IM) conversation (Figure 

1.4.1).  

 You can chat with collaborators in real time 

by using Office 365 and Skype for Business, 

and you can view presentation activity, all 

from the top-right corner on the ribbon.  

 Everyone who participates in the co-

authoring session sees changes being made 

to the document in real time. 

 

 

 

TIP #5 (Skype for Business) - On the move, easily Transfer your 
Skype for Business call to your smartphone  
You can transfer a Skype for Business call to another person or number.  

 

 For example, if you need someone else to handle the call, you can transfer to them. Or if you need to 

Figure 1.3.1 

Figure 1.4.1 
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leave your office, but want to continue your conversation, you can transfer the call to your cell phone.  

 

Here’s what you do:   
 

Transferring a Skype for Business call (Figure 1.5.1):   

1. Click the Call Controls button in the call window. 

2. Click Transfer, type the number, or enter the number in the text box. The Transfer Call window appears. 

3. Click one of your numbers, such as your mobile phone, (these are the numbers that were added to your 

Skype for Business account). 

4. Click Transfer. 

 

 

 

 

 

 

 

  

Figure 1.5.1 
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Improve Efficiency and Profitability  

Collaborate on files from anywhere, with Business-class mobile 
apps 
From work to your favorite café, Office 365 keeps you connected to what’s important—friends, family, projects, 

and files.  

 

Keep your projects coordinated... 

 Help teams stay in sync -- Keep everyone up to date and working together as a team. Office 365 gives 

you many different ways to help ensure that everyone can find exactly the files they need fast and that 

all team members are moving forward together.  

 Build a team library -- Keep project emails and shared documents together in one place with a project-

specific mailbox only team members can access, so no time is wasted searching for what you need.  

 Create a team site -- You control access to your team site. And with automatic policies, rights 

protection, and archiving, you can safeguard your team assets. 

 

Share files internally and externally, with Office 365  
In our networked world, file sharing isn’t restricted to inside the office.  
 

Share internally and externally... 

 You control access to files -- Whether internally or externally shared, you control who sees and edits 

each file. And you can create, edit, and review with others to avoid back-and-forth hassles and save time 

in the process.  

 Work together on the same file -- No more emailing documents around and losing track of the latest 

version. Easily add, respond to, and track comments and status updates on one version of the 

document.  

 The power of social networking -- Social networking enhances collaboration and sparks innovation. 

Get updates on documents and sites delivered automatically. 

 

TIP #6 (Excel) - Quickly split column data with Flash Fill  
When you need to enter a lot of repetitive information in Excel, such as dates, the AutoFill feature can help. But, 

when you need to quickly split a single column of data into multiple columns, just by typing, Flash Fill can do the 

work for you. Flash Fill recognizes patterns in your data, and completes the data accordingly.  

 

Here’s what you do:  
 

For example, if you have a list of names that is not formatted the way you need it, or that you want to 

split out (like he first name from an email address)… (Figure 2.6.1): 

 Start by typing the first name the way you want it (into the First Name column).  

 Then, start typing the next name into the next cell down, and Excel provides a preview of the names 

formatted the way you want.  

 Press Enter and Flash Fill will fill-in the names for you.  

 Note: Flash Fill works best on consistent data, and doesn’t work on text that’s mistyped (e.g. inconsistent 

capitalization, like “nAnCy”).  
Once the data is filled-in, Flash Fill provides a drop-down box with various options you can apply to your data.  
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Note: In Excel 2016, the Flash Fill feature is turned on by default and automatically fills your data when it senses a 

pattern. But if it’s not working as expected, you can turn it on by clicking File tab (Backstage menu), then Options. 
Click on Advanced and check the Automatically Flash Fill box.  

 

TIP #7 (Excel) - Need to visualize your data? Use the Quick 
Analysis tool in Excel  
It used to take a bit of work to analyze your data, but now it only takes a few steps. You can instantly create 

different types of charts, including line and column charts, or add miniature graphs (called Sparklines). You can 

also apply a table style, create PivotTables, quickly insert totals, and apply conditional formatting.  

 

Here’s what you do:  
 

Select the cells that contain the data you want to analyze (Figure 2.7.1). 

 Click the Quick Analysis button image button that appears to the bottom right of your selected data (or 

press CRTL + Q). 

 In the Quick Analysis gallery, select a tab you want. For example, choose Charts to see your data in a 

chart.  

 Pick an option, or just point to each one to see a preview. 

 

You might notice that the options you can choose aren’t always the same. That’s because the options change 
based on the type of data you have selected in your workbook. 

 

 

Figure 2.6.1 
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Which analysis feature should I use? 

 

If you’re not sure which analysis option to pick, here’s a quick overview:  
 Formatting - lets you highlight parts of your data by adding things like data bars and colors. This lets 

you quickly see high and low values, among other things. 

 Charts - Excel recommends different charts, based on the type of data you have selected. If you don’t 
see the chart you want, click More Charts. 

 Totals - let you calculate the numbers in columns and rows. For example, Running Total inserts a total 

that grows as you add items to your data. Click the little black arrows on the right and left to see 

additional options. 

 Tables - make it easy to filter and sort your data. If you don’t see the table style you want, click More.  
 Sparklines - are like tiny graphs that you can show alongside your data. They provide a quick way to see 

trends. 

 

TIP #8 (Excel) - Discover geospatial patterns with 3D Maps  
With 3D Maps, get access to the popular 3D geospatial visualization tool that allows you to discover patterns in 

your data as it relates to location, time, and geopolitical context.  

 

The popular 3D geospatial visualization tool, previously named Power Map, has been renamed 3D Maps and is 

now available to all Excel 2016 customers.  

 

Here’s what you do:   
 

Figure 2.7.1 
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Access 3D Maps and other visualization tools by clicking 3D Map on the Insert tab. 

 

Creating your first 3D Map…  

 

When you have Excel data that has geographic properties in table format or in a Data Model—for example, rows 

and columns that have names of cities, states, counties, zip codes, countries/regions, or longitudes and 

latitudes—you’re ready to get started. Here’s how: 
 

Preparing your data (or using sample data workbooks)… (Figure 2.8.1):  

1. In Excel, open a workbook that has the table or Data Model data you want to explore in 3D Maps. 

 For information about using your own data, see Prepare* your data for 3D Maps 

(https://support.office.com/en-us/article/Get-and-prep-your-data-for-3D-Maps-a732ef13-4f84-414d-

9ed2-e97911115a44?ui=en-US&rs=en-US&ad=US). 

 If you don’t have data to explore yet, try downloading one of our sample data workbooks 
(https://support.office.com/en-us/article/Get-started-with-Power-Map-88a28df6-8258-40aa-b5cc-

577873fb0f4a?ui=en-US&rs=en-US&ad=US#__exploring_sample_datasets). 

2. Click any cell in the table, 

3. Click Insert > 3D Map, 

 (Clicking 3D Map for the first time automatically enables 3D Maps.) 

 3D Maps uses Bing to geocode your data based on its geographic properties. After a few seconds, the 

globe will appear next to the first screen of the Layer Pane. 

4. In the Layer Pane, verify that fields are mapped correctly and click the drop-down arrow of any incorrectly 

mapped fields to match them to the right geographic properties. 

 For example, make sure that Seattle is recognized as a City in the drop-down box. 

5. When 3D Maps plots the data, dots appear on the globe.  

Figure 2.8.1 
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Notes:  

 For best results with 3D Maps,  

o use data in an Excel table or (preferably) a Data Model you created in Excel 

(https://support.office.com/en-us/article/Create-a-Data-Model-in-Excel-87e7a54c-87dc-488e-

9410-5c75dbcb0f7b?ui=en-US&rs=en-US&ad=US),  

o or by using Power Pivot (https://support.office.com/en-us/article/Get-started-with-Power-Pivot-

in-Microsoft-Excel-fdfcf944-7876-424a-8437-1a6c1043a80b?ui=en-US&rs=en-US&ad=US).  

o If the data you want to use in 3D Maps is stored on external servers, you can connect to it from 

Excel and add it to the Data Model. 

 3D Maps doesn’t support hierarchies (groupings of data fields) that you create in the Data Model. 
 

TIP #9 (Outlook) - Save time by quickly Attaching Files 
Without Searching in Outlook  
Attach a document from your recent items and share them from OneDrive or SharePoint with email recipients. 

Also configure sharing permissions so that all the recipients have access to the attached file without having to 

leave the app.  

 

Here’s what you do:  
 

 In Outlook 2016 you can easily attach documents you most recently worked on to your emails from the 

Message or Insert tab (Figure 2.9.1).  

 Quickly add files and other items, such as messages, contacts, or tasks to your messages in Outlook for 

Windows.  

 When you attach files from OneDrive, OneDrive for Business or SharePoint, you can share them as View 

only, or give the recipients Edit permissions, which helps them collaborate easily on one copy that 

everyone works on.  

 

Figure 2.9.1 
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Notes:  

 When attaching files from the “Recent Items” list that are stored in the Cloud (e.g. OneDrive, 
SharePoint…), you can attach a copy of the local version of the file itself, or the Cloud storage location’s 
URL to the file (if the permissions have been “previously” set on the file--or the recipient will receive a 

“cannot open file” error message).  
 Outlook doesn’t have a predefined limit, but many Internet service providers (ISPs) restrict the size of 

messages that you can send in addition to the size of your email mailbox.  

 

TIP #10 (Outlook) - Use Outlook to check availability, 
Schedule a Skype Meeting, and set meeting options  
You can use Outlook or Outlook Web App to schedule a Skype meeting--the same way you schedule meetings 

normally but with one or two extra clicks.  

 

 And if your account is configured for dial-in conferencing, the Skype meeting request will automatically 

include call-in information (phone number and conference ID). 

 If you don’t use an Outlook program (or Windows), you can set up new meetings using Skype for 

Business Web Scheduler. Access it at https://sched.lync.com, or learn more at Lync Web Scheduler.  

 

Here’s what you do:   
 

Schedule a Skype Meeting using Outlook:  

To schedule a Skype meeting, you need a sign-in address and password from an organization that uses Skype for 

Business. 

 Open Outlook, and go to your calendar. 

 On the Home tab ribbon, in the Skype Meeting section, click New 

Skype Meeting (Figure 2.10.1). 

 Set up the meeting as you typically would: 

o In the To box, type the email address of each person you’re 
inviting, separated by semicolons. 

o In the Subject box, type a name for the meeting. 

o If you’ll have in-person attendees, either click Room Finder, in 

the Options section of the Meeting tab, and then find a room 

or, in the Location box, type a meeting location, such as a 

conference room. 

o Select a start time and end time.  

o Notes:  To look for a time that works for everyone, click 

Scheduling Assistant, in the Show section of the Meeting tab 

ribbon. 

 In the meeting area, type an agenda. Be careful not to change any of 

the Skype meeting information. 

o Important:  Scheduling a meeting with the default options, like we just did, is suitable for small, 

internal meetings, such as casual meetings with a few coworkers. If you have a meeting with 

people outside your company, or you’re scheduling a large event, change the meeting options 
before sending the invites to better fit your meeting requirements. In the meeting request, on 

the Skype Meeting section of the Meeting ribbon, click Meeting Options, and then select the 

appropriate options. 

 (Optional) Preload your meeting attachments. That way, when participants join the meeting, everything is 

ready to go.  

o See Preload attachments for a Skype for Business meeting. 

Figure 2.10.1 
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 (Optional) In the Show section of the Meeting ribbon, click Scheduling Assistant to make sure you have 

the best time for the meeting. 

 You're almost done. Just double-check the information and click Send. 

 

You can also set up an online meeting using Outlook Web App (with a Business or Enterprise subscription 

to Office 365):  

These can include information such as:  

 Call-in details, like a Join online meeting link appear in the message area.  

 If your account is configured for dial-in conferencing, you’ll also see a Find a local number link. 

 Notes: If you don't see the Online Meeting link, it could be for one of the following reasons: 

o You’re not using a browser that supports the full version of Outlook Web App. 
o Your Office 365 subscription does not include Skype for Business. 

o You’re logged in as a user who hasn’t been granted a license for Skype for Business. 
 

TIP #11 (Word) - Quickly and easily apply consistent 
document formatting with Styles  
Word 2016 includes many styles designed to help you produce a professional quality document, so you can 

quickly and easily apply a set of formatting choices consistently throughout your document.  

 

 A style defines the formats to apply, such as font, size, color, and spacing.  

 To format text quickly and consistently, use heading and paragraph styles.  

 Word 2016 includes many built-in styles that specify the formatting to use for text, such as font, size, line 

spacing, and color.  

 The heading styles also make it possible to structure your document in useful ways. For example, Word 

2016 uses heading styles to create a table of contents (press Alt+S, T).  

 

Here’s what you do:  
 

Follow these steps to apply a “paragraph” style from the Styles gallery (Figure 2.11.1): 

1. Place the insertion point in a paragraph, or select a range of paragraphs. 

2. To browse the most common styles in the Styles group, press Alt+H, L. Alternate views:  

 Or, to browse all styles from the Apply Styles task pane, press Ctrl+Shift+S.  

 Or, to browse all styles from the Styles task pane, press Ctrl+Alt+Shift+S. 

3. Move through the styles until you see the one you want, and press Enter.  

 

For example, to create a title, select the Title style which applies a 28-point Calibri Light font in steel blue, when 

you start from the default blank document in Word.  
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Tip: To remove a style from text, use the Clear All Formatting button by pressing Alt+H, E. 

   

TIP #12 (Word) - Easily navigate your way through large or 
complex documents  
With the Navigation Pane in Word 2016, find images, tables, comments, and other objects.  

 

The Navigation Pane offers several options for locating specific content in your document:  

 You can search for and replace items such as text, images, captions, bookmarks, or certain types of 

formatting such as paragraphs or page breaks,  

 You can use the Go To command to go to a particular instance of content in your document,  

 For advanced users, you can also extend your search by using wildcards, codes, or regular expressions to 

find words or phrases that contain specific characters or combinations of characters.  

 

One example of how to use the Navigation Pane…  
 

Here’s what you do:  
 

To search for objects like tables, graphics, comments, footnotes, endnotes, or equations, do the following 

(Figure 2.12.1): 

 On the Home tab, in the Editing group, click Find. Or press Ctrl+F on your keyboard. 

 The Navigation pane is displayed. 

o Click the arrow on the right side of the search box, and then choose an option from the list. 

o The search results are displayed below in the search box.  

 Select a result to see it in your document, or browse through all the results by clicking the arrow 

controls. 

Figure 2.11.1 
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Tip: For more details on the Navigation Pane/Sidebar and more advanced options, type “navigation pane” in the 
Tell Me box, choose “Get Help on navigation pane”, then choose “Find and replace text and other data in a Word 
document” from the list in Help.  
 

 

TIP #13 (PowerPoint) - Master Slide saves time by changing 
the Default Font for all text  
Rather than updating your slides one by one, you can save time by changing the default font for your entire 

presentation. 

 

 Any changes you make to the Slide Master will affect all other slide templates. 

 Eliminate additional formatting steps in the future by saving the updated Slide Master as a new 

template. 

 

Here’s what you do:  
 

To change the default font in the Slide Master (Figure 2.13.1):  

1. Click View > Slide Master. 

2. On the Slide Master tab, click the Fonts drop-down menu. Select the font you want to use for all the slides in 

the presentation. 

Note: Any changes you make in this Slide Master view affect all the other slide templates.  

3. Click Close Master View. The text throughout your presentation will automatically update to the new font.  

 

Figure 2.12.1 
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Tip: You can save time and eliminate additional formatting steps in the future by saving the updated Slide Master 

as a new template. For details, see Help for Create a new template to save your default font.  

 

TIP #14 (PowerPoint) - Give your presentations more impact, 
insert or Link to a YouTube video  
You can insert or link to a video on YouTube, OneDrive, Facebook and more, and then play it during your 

presentation.  

 

Here’s what you do:  
 

If you know the name of the video hosted on YouTube, do the following (Figure 2.14.1):  

1. Click the slide that you want to add a video to.  

2. On the Insert tab, click Video > Online Video.  

3. In the Search YouTube box, type the name of the video that you 

want to insert.  

4. Select the video from the search results, and click Insert.  

5. A video rectangle is placed on your slide, which you can move and 

resize as you like. To preview your video on your slide, right-click 

the video, and then click Preview.  

 

 

Figure 2.13.1 

Figure 2.14.1 
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TIP #15 (Skype for Business) - Record all aspects of a Skype for 
Business session with Recording and Playback  
The recording feature allows organizers and presenters to record all aspects of a Skype for Business session, 

including:  

 who entered the meeting,  

 audio and video, and content from IM conversations,  

 program sharing sessions,  

 PowerPoint presentations,  

 handouts,  

 whiteboards,  

 and so on. 

 

Here’s what you do:   
 

To capture audio, video, IM, and what’s being presented (Figure 2.15.1):  

1. In the lower-right of meeting window, click the More Options button. 

2. Click Start Recording. 

3. After the meeting, go to Manage Recordings to publish, play, rename, or delete the recording. 

 

Notes:  

 Organizers and presenters can choose 480p, 720p HD, or 1080p Full HD as their preferred resolution for 

client-side recordings.  

 Recordings are saved to the organizer’s or presenter’s computer. To make a recording available to 
others, the organizer or presenter can move or copy the recording to a shared location.  

 To learn more about changing the location and resolution of a Skype for Business recording, see Skype 

for Business recording location and resolution.  

 

Still tethered to your desk phone? Cloud PBX with advanced 
features  
Replace your traditional phone system by adding a set of advanced calling features delivered in Office 365 with 

Figure 2.15.1 
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Skype for Business Online. 

 Operate your business phone system in the cloud and eliminate the need for traditional PBX hardware 

and the associated maintenance costs. 

 Make and receive business calls in the office, at home, or on the road, using your phone, PC, or mobile 

device. 

 Instantly transform basic calls into productive, collaborative sessions with text, video, and desktop 

sharing. 

 Works seamlessly with Office 365  

 

Offer your customers the ability to schedule their own 
appointments online, with Bookings  
Microsoft Bookings is an online and mobile app for small businesses who provide services to customers on an 

appointment basis.  

 

 Bookings provides your business a unique web page that your customers can use to schedule 

appointments directly online, anytime, even when you’re not around to pick up the phone or respond to 
an email. 

 

Examples of such businesses include hair salons, dental offices, spas, law firms, financial services providers, 

consultants, and auto shops. Bookings has three primary components: 

 A booking page where your customers can schedule appointments with the staff member who should 

provide the service 

o The web page is simple to use: the customer first selects the service they want and, based on 

availability you provide, chooses a day and time when you or one of your staff is available, 

enters their contact information and books the appointment. 

o The web page looks great on both larger screens and mobile devices. It’s easy to link to your 
scheduling page from an email that you send to customers or from your business’s website or 
Facebook page. 

 A set of web-based, business-facing pages where business owners can record customer preferences, 

manage staff lists and schedules, define services and pricing, set business hours, and customize how 

services and staff are scheduled 

 A business-facing mobile app where business owners can see all of their bookings, access customer 

lists and contact information, and make manual bookings  
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Safeguard Your Business  

For the security and control you need, Business-class mobile 
app 
With an Office 365 for business subscription, you get mobile apps that help you get more done from your 

favorite device while keeping your data secured.  

 

Security & management... 

 Built-in security and tools -- Keeping corporate data secure on mobile devices is a top priority. Office 

365 helps you meet this challenge by providing built-in security plus a set of tools* to manage access to 

data across phones and tablets.  

 Easily control access -- You can apply device-specific security policies to ensure that data is synced and 

accessible only on authorized phones and tablets. Setting up and managing your policies is simple.  

 Wipe data remotely -- When you need to wipe Office 365 data from selected devices, you can do it 

remotely. 

 

*Office 365’s Mobile Device Management (MDM) capabilities work to keep your data safe in three ways: 
 Conditional Access -- You can set up security policies on devices that connect to Office 365 to ensure that 

Office 365 corporate email and documents can be accessed only on phones and tablets that are managed 

by your company and are compliant. Behind the scenes, Office 365 leverages Microsoft Intune and the 

Microsoft Azure Active Directory to deliver this capability. The Conditional Access policies apply to Office 

applications such as Word, Excel, PowerPoint and other business applications—making management 

easier for admins while ensuring users can securely work with their preferred productivity applications. 

 Device management -- You can set and manage security policies such as device-level pin lock and 

jailbreak detection to help prevent unauthorized users from accessing corporate email and data on a 

device when it is lost or stolen. Additional settings and rich reporting are also available within the Office 

365 admin center so you can gain critical insights about devices accessing your corporate data. 

 Selective wipe -- You can easily remove Office 365 company data from an employee’s device while 
leaving their personal data in place. This is an increasingly important requirement as more businesses 

adopt a “bring your own device” (BYOD) approach to phones and tablets. 
 

If you are looking for protection beyond what’s included in Office 365, you can subscribe to Microsoft Intune, 

part of the Microsoft Enterprise Mobility Suite, and receive additional device and application management 

capabilities for phones, tablets and PCs. This includes the ability to restrict actions such as cut, copy, paste and 

save as to applications managed by Intune—helping keep corporate information even more secure. 

 

These new capabilities help you better manage and protect access to Office 365 data while enabling 

people to be mobile and productive from anywhere.  
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Notes 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

Thank You 
 

 

Learn more 

https://business.microsoft.com 

 

 

© 2016 Microsoft Corporation. All rights reserved. This document is for informational  

purposes only.  Microsoft makes no warranties, express or implied, in this summary. 

INSTRUCTIONS AND SCREENSHOTS IN THIS GUIDE APPLY TO OFFICE 2016 & OFFICE 365 

 

Some features are only available with an Office 365 Business/Enterprise account


